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Thank you for choosing our product. If there are any questions, or requests, please do not hesitate to
contact the dealer.

Disclaimer

e Contents of this document are subject to change without prior notice.

e Best effort has been made to verify the integrity and correctness of the contents in this
document, but no statement, information, or recommendation in this manual shall constitute
formal guarantee of any kind, expressed or implied. We shall not be held responsible for any
technical or typographical errors in this manual.

e Theiillustrations in this manual are for reference only.

e Due to uncertainties such as physical environment, discrepancy may exist between the actual
values and reference values provided in this manual. The ultimate right to interpretation resides
in our company.

Conventions

Convention Description

Commands, keywords, parameters and GUI elements such as window, tab,

Boldface font .
dialog box, menu, button, etc.

Italic font Variables for which you supply values.

Separate a series of menu items, for example, Device Management > Add
Device.
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1 Introduction

EZStation 3.0 is a video management software. It provides video surveillance services including live
view, playback, device management, recording schedule, alarm configuration, video wall, people
counting, and e-map. The software is easy to deploy and operate, suitable for small and medium-size

applications such as for super market, parking lot and residential area. For more details, see
datasheet.

NOTE!

e The software has different versions and shall be installed on a compatible operating system. Please
refer to the datasheet for details.

e Functions may vary depending on factors including but not limited to software version, device and
version, and how the device is managed by the software (i.e., directly connected camera or NVR
connected camera).

S

e This manual is not intended for a specific software version. Some functions or features described in
this manual may be available to certain version(s) only.

e Directly connected camera: Camera that is directly managed by the software (in comparison with
NVR connected camera).

e NVR connected camera: Camera that is managed by the software via an NVR (in comparison with
directly connected camera).

e IPC: IPC, IP camera and camera refer to the same thing in this manual.
e  PC: The computer that runs the software, also mentioned in this manual as the client.

2 System Requirements

The PC that hosts the software shall meet performance requirements. The requirements may vary,
depending on how you use the software. For example, live view at high resolution in multiple
windows requires higher system performance.

Software Version System Requirements

0S: Microsoft Windows 7/8/10 (64-bit)
64-bit CPU: Intel Core i5 3.1 GHz or higher
Memory: 4 GB or higher

OS: Microsoft Windows 7/8/10 (32-bit or 64-bit)
CPU: Intel Pentium IV 3.0 GHZ or higher (4 Core, 3.0 GHz recommended)
Memory: 2 GB or higher

32-bit

Note: The 64-bit Windows shall be able to host 32-bit software.




Software Version System Requirements

0OS: Mac 0S 10.11 or higher

Mac CPU: Intel Core i5 3.1 GHz or higher

Memory: 4 GB or higher

@ NOTE!

The 64-bit OS and software are recommended. Live view and playback consumes RAM, and the
32-bit software has a relatively small RAM. When RAM is running low, the software will be unable to
play more channels of live or recorded videos, and it will display a message indicating insufficient
RAM.

Installation and Startup

%

1. Double-click the .exe file (for Windows) or the .pkg file (for Mac), and follow the wizard to
complete the installation.

2. When installation is complete, double-click the shortcut icon to start the software.

3. Login with your username and password. For first-time use, create an admin account and set up
security questions before login.

CAUTION!

e Please set a strong password with at least 9 characters including letters, digits and special
characters.

e If you forget password, click Forgot Password. It is only available when security questions have been
set. To set security questions or change password, click Username in the upper right corner after
login.

4. You see the main page when logged in. The main page includes the control panel, some
functional buttons and the system menu.

NOTE!

For first time use, a config wizard will guide you to add devices and start live view. The wizard uses
the default username (admin/123456) to add devices.

GUI Introduction

The main page is displayed after you log in. The main page consists of the control panel and some

functional buttons.



€) Ezstation

e The control panel includes the Common and Basic/Smart areas. Click an icon to access the
corresponding module. You may drag an icon to change its position with another icon.

e  Click the buttons in the top right corner:

Icon Description

B~ Menu. Click an icon on the menu to access the corresponding module.

= Change appearance. You can choose the light or the dark theme color for

L the client.

E Switch account.

Click to change password.
Note:

Username When changing password, you also need to set security questions at the
same time if it has not been set yet, so that you can reset the password if
you forget it.

= Lock the GUI
Open configuration wizard, user manual, view version number and
update information.

E Note:

If updates are available, you can click to view details and download the
new version.

E View customer information.

e The buttons in the bottom left corner:



lcon Description

View realtime alarms, turn on/off alarm sound, enable/disable
alarm-triggered live video.

View alarm triggered live video.

Download recording.

E View and manage download tasks.

5 Device Management

Devices include encoding devices, decoding devices, cloud devices, access control devices and
network keyboards. The software supports up to 64 local devices and 64 cloud devices, up to 512
local channels and 512 cloud channels.

5.1 Encoding Device

5.1.1 Add an Encoding Device

Encoding devices include IPC (also referred to as IP camera, camera, or video channel in this manual),
Network Video Recorder (NVR) and hybrid NVR.

E NoTE!
e Managing a device with different management software programs may cause unexpected problems.
e Please always add devices as admin (enter username "admin").

Click Device Management on the control panel and then follow the steps:
1. Click Device > Encoding Device. The page is divided into two areas with two lists:

e Online Device list: The software searches online devices and refreshes automatically. Note: The
discovered devices are not added yet, and you need to add them manually (see step 2).

e Managed Device list: lists devices that have been added to the software.
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On the Online Device list, select device(s) and then click Add. You may add devices to different
groups.

The software uses the default username (admin/123456) to add a device. If the password of a
device has been changed and is not 123456, you need to change the password in step 3.

In the Online Device list, you may:
® Click Refresh to refresh the list.
® Click Search Config to specify a network segment to search.

® Right-click a device to visit its Web interface.

On the Managed Device list, check the status of the added devices and do the following:

To How To

1)  Click Add.

2) Choose a mode. The device username (admin) and password are always
required, regardless of the mode you choose.

e |P/Domain: Add a device with a known IP address.
Add device e [P Segment: Add multiple devices with continuous IP addresses.
e EZDDNS: DDNS must be enabled on the device and port mapping must be
completed beforehand. See Appendix for details.
3) Click Add to add to the default group, or Add to Group to add to a specified
group, see Group management.

Select device(s) and then click Edit. This button is especially useful when you

Edit Device . . .
want to set the same username and password for adding multiple devices.

Select device(s) and then click Delete. The deleted online devices are still on the

Delete device . .
Online Device list.

Sync time Click Time Sync to sync your PC's system time to the selected devices.

] ) Click Status to view device online/offline status, alarm subscription status,
View device recording status, and storage medium status.
status

You may refresh manually or set an interval to refresh automatically.




To How To

: Edit device name, IP address, username/password. If the device status
is Offline (incorrect username or password), click this button and change
the password to the actual password. You may also double-click to edit a

Use buttons in device.

the Operation

column ° E3 Configure image, encoding and OSD settings of a device (see Configure

an Encoding Device).

: Visit the Web interface of the device.

. E: Restart device.

5.1.2 Configure an Encoding Device

24

On the Managed Device list, cIickEfor an online device to configure image, encoding, OSD and

temperature measurement settings without opening the Web interface of the device.

NOTE!

e This function requires device support and it may be unavailable if the device version is too low.
e Temperature measurement parameters are available to thermal cameras only.
e The configurations displayed may vary with device version and how the device is managed.

e For detailed explanations of image, encoding, OSD and temperature measurement parameters,
please see device user manual.

e OSD configuration and temperature measurement configuration are not supported by the Mac
version.

134 001111 =




Note:

e The changed image and OSD settings take effect immediately. Encoding and temperature
measurement settings must be saved first before they take effect.

e For an NVR, you need to select a camera from the drop-down list.

e When configuring OSD, you can double-click the image to display in full screen; the blue boxes
(Areal, 2 ...) appear only in the preview and do not display on the live view image. You can drag
an OSD to relocate it.

5.1.3 Group Management

You can create groups and manage cameras in different groups.

1. Addagroup.

Tevice

W

2. Import cameras to the group.

+ Import Camera Edit _|L-||_ Deleate onfiguration

[] Nane IF 4d Status

Import Camera

Encoding T

[] TP ET-E31HM_LS

- [] == Hves

e To import cameras: click the group on the right, select cameras on the left, and then click
Import Selected. To import all cameras, click Import All.

e Toremove a camera from a group, place the mouse pointer on the camera and click Delete.



e Torename a camera in a group, place the mouse pointer on the camera and click Rename.

5.2 Decoding Device

You need to add a decoding device before you can use the video wall function. The steps are similar
to adding an encoding device. See Add an Encoding Device for reference.

Note: Add a decoding device as admin.

5.3 Cloud Device

=2 NOTE!

The software can manage up to 64 cloud devices simultaneously, including your own devices and
devices shared from other cloud accounts. If the total number of cloud devices exceeds the limit,
you can click Device Details and use the Add Manage or Cancel button to specify the cloud devices
you want to manage.

Click Device Management on the control panel and then follow the steps.
1. Click Device > Cloud Device.
2. Click Register to sign up for a cloud account; if you already have one, proceed to step 3.

3. Enter your username and password for your cloud account, and then click Login. Devices under
your cloud account are listed, including your cloud devices (under My Cloud Device) and devices
shared from other cloud accounts (under Shared Cloud Device).

¥alid Until

e Use the buttons under Operation to edit device name, configure image, encoding and OSD
settings, open the Web interface of the device, or restart a device.

e Click Cancel to cancel the management of a device without deleting the device from the cloud
account.

e Click TimeSync to keep a device synchronized with your PC's system time.

e Click Device Details to add, edit, delete cloud devices, to share or cancel sharing, to manage or

cancel management.



Device Details

Wy Clomd Devi b Manage O B 2 Edit T Delete

oG

Added Cloud Name IF Address

O 000
58

Shared Cloud Device(0) 16} Add Manage

[0 added Der Hame Model Valid Until

Tips:

e Click Add to add device(s) to your cloud account (the register code required is displayed in the
Web interface of the device; see device user manual for details); click Delete to delete device(s)
from your cloud account.

e Click Add Manage to add device(s) to the software; click Cancel to cancel management without
deleting the device from the cloud account.

e Double-click a device or click Edit to change the device's name. To sync the new name to cloud,
select Sync to Cloud.

e Click Share to share device(s) with another cloud account. Set a sharing period and permissions
as needed. The permissions are pre-configured on the device.

e Click Sharing Records to view sharing history or cancel sharing(s) with other cloud accounts.

e Click Cancel Sharing to cancel sharing(s) from other cloud accounts.

5.4 Access Control Device

See Add an Encoding Device for the steps to adding an access control device. Please add access

control devices as admin.

5.5 Network Keyboard

A network keyboard can be used to control live video, playback, PTZ camera and sequence resource

on a video wall.

The following steps describe how to play live video on a video wall. Before you start, refer to the

keyboard user manual to connect the keyboard to your PC. And then, click Device Management on

the control panel and follow the steps.

1. Add a camera. On the Camera tab, click Add, select the camera to play on the video wall and
click OK. The camera appears on the list.

Tip: You will use the number (e.g., 222) later when operating the keyboard.



2. Add avideo wall. On the DX Video Wall tab, click Add, select a video wall and then click OK. You
need to configure video wall first. See Video Wall for details.

Tip: You will use the number (e.g., 1) later when operating the keyboard.

3. Add a sequence resource. On the Sequence Resource tab, click Add, select a sequence resource
and then click OK. You need to configure sequence resource first. See Sequence Resource for

details.

Tip: You will use the number (e.g., 1) later when operating the keyboard.

4. The following operations are on the network keyboard.

a. Enter the keyboard number in step 2 (e.g., 1), then press AUXA4.
b. Enter the window number in the top left corner (which is 1 in both A and B), then press MON.

c. Enter the split-screen number, then press WIN. If the window is split (as in A), enter the split-screen
number 3; if the window is not split (as in B), enter 1. This step is only required for playing live video
on video wall. For playing sequence resource, skip this step.

d. Select the camera or sequence resource to play on the video wall.
® Live video: Enter the keyboard number in step 1 (e.g., 222), then press CAM.

® Sequence resource: Enter the keyboard number in step 3 (e.g., 1), then press CAM_G.
5. After live video starts on the video wall, you can:

e Use the joystick to control the rotation of a PTZ camera, and use the Zoom and Focus buttons to
control the zoom and focus.

e Usethe button to switch live video to recording.

See keyboard user manual for more information.
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6 Live View

6.1 Live View
Click Live View on the control panel to view live video from cameras.

6.1.1 Play Live Video

1. Onthe Camera tab, double-click a camera or drag it to a window to start live video.

- B WRil14/18)

+ I w

12 : 7l 1"

— A ) ' 3 -
2. Right-click a camera to choose a stream type, rename the camera, view/change alarm output
status.

View/change alarm output status: Right-click an IPC or a channel under an NVR to view or
change its alarm output status. Alarm output needs to be configured beforehand on the device.

Or, hover the mouse on an NVR, cIick to view or change the alarm output status of the NVR

and all the channels under it. Click the button in the Operation column or the button on the top
to change alarm status.

11



#larm Output Control

o

04_0_AlsrmOutput_1
04_0_alarmOutput_2
04_0_sl srmlutput_3
104_0_Al=rmutput_4

04_0_#1 ermlutput DZ_1

3. You may drag the image to play it in another window.

4. Double-click a window to maximize it, and double-click again to restore.

After maximizing a window, move your mouse to the left or right side on the live view page, and then

click or Edl to switch to the live video of previous or next channel.

12



5. Use the live view toolbar or window toolbar during live view.

6.1.2 Play Live Video by View

By default view
On the View tab, double-click a default view or click Play to start live video from the corresponding
number of cameras on the camera list: 4 cameras for 4-split view, 9 for 9-split view, 16 for 16-split
view, and 25 for 25-split view.

Take the 4-Split view as an example.

- - Defanlt ¥iew

I_E:pli t

P

4-2plit ()| [>
Flay

9—=5plit

16—=5plit

Live video from the first 4 cameras on the camera list will be played, illustrated as below.

Cam 1 Cam 2

Cam3 | Cam4
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By custom view
Play live video from specified cameras by a custom view.

1. On the View tab, click the Add View button to create a view. You may also click View on the
control panel to add a sequence resource.

= - Default View

1=5plit

_ Cretam W am [ 1 +
' Cuztom Wiew | )

ooz Add View

1

2. Select a window layout. CIickE to edit a custom layout, use Combine or Undo when editing.

gt

Edit 4

Default

EID]]EEI[QIE@@E@

1 4

Eﬁﬂﬁﬂ---

10 10 16 ir

== te K

Drag cameras or sequence resources to the intended windows one by one.
4. Click OK.

Double-click the custom view or click Play to start live video from cameras (specified in step 3)
in the corresponding windows in the layout (set in step 2).
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Enter Eewwords

= . Default ¥iew

1-5plit
4—Split
9—=plit
f—Split
Split
- F Custon View
ooz = [>

1 Flay

6.2 Live View Control

6.2.1 Live View Toolbar

The live view toolbar is at the bottom of the live view window.

000000 000 0

- FB @ @ B OH

Button Description
A Set window layout.
B Save the current view directly or as another view.
C Close all windows playing video.
D Snapshot all.
E Start recording of all windows playing.
F Stop recording of all windows playing.
G Pause/resume sequence display
H/I Play the previous/next group or view in sequence display.
J Switch to full screen mode. Press Esc to exit.

6.2.2 Live View Window Toolbar

The window toolbar appears when you place the mouse pointer on a live view window. The toolbar

is effective only to the current window.
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Main(4. 56Mbps, 1536x1536)

Button Description

Take a snapshot. The snapshot format and storage path are configurable in System

A
Configuration.

B Records live video playing in current window to the PC.
The video format and storage path are configurable in System Configuration.

C Digital zoom. When enabled, drag the mouse to draw an area on the image to zoom
in on, and use the scroll wheel to zoom in or out.

D Adjusts the speaker volume or mute it for the PC.

E Two-way audio.

Starts instant playback. Plays back the live video playing in the current window for
F the last 5 minutes and 30 seconds. The playback pauses at the end, and you need to
start live video manually.

Enable/disable POS OSD. When enabled, POS OSD appears on the live view if the POS
machine is connected to a camera via NVR.

The POS OSD is configurable in System Configuration, including the position, size,
G color and duration.

Note:

You need to configure POS basic information on the NVR's web interface, and after
that you can view the POS information on the client.

Trigger alarm output. This requires NVR/IPC to be connected to external devices. For
H example, if the IPC’'s alarm output interface is connected to a lamp, then this button
can control the switch of the lamp.

I Stream type, bit rate and resolution of the current video.

NOTE!

e The toolbar shows E when the camera is a PTZ camera. Click this button to open the PTZ control
panel.

e The toolbar shows s
control panel.

when the camera is a fisheye camera. Click this button to open the fisheye

[=H
e The toolbar showswhen the camera is a multi-sensor camera. Click this button to enable
tracking mode.

e The toolbar showswhen box-dome linkage is configured on the camera. Click this button to
open the Box-Dome linkage.

16



6.2.3 Live View Shortcut Menu

A shortcut menu appears when you right-click a live view window. Some items on the menu provide
same functions as the live view toolbar and window toolbar. Some are described in the table below.

Parameter Description

Select a stream type for the current window: auto, main, sub and third stream
(options may vary with device).

Note:

Sub Stream and Third Stream are not displayed if not available.

Stream Type

Trigger an alarm manually.
Note:

It is recommended that you first configure the action(s) to trigger (see
Configure Alarm-Triggered Action). A click of this button will generate an alarm
and trigger the configured action(s).

Manual Alarm

Display frame rate, resolution, bit rate, video compression format, and packet

Camera Info )
loss rate for the window.

System

Configuration Open the System Configuration window (See System Configuration).

E NoTE!
The default stream type is auto.
e For local devices, the client chooses a stream type according to the screen layout.
e 4 windows or less: Main stream
e 4to 16 windows(16 included): Sub stream
e More than 16 windows: Third stream
e For cloud devices, the default is third stream.

6.3 PTZ Control

Control the rotation direction and speed, pan/tilt/zoom, focus of a PTZ camera. The software also
provides other functions including 3D positioning, preset, and patrol functions.

=/ NOTE!

PTZ control is available to PTZ cameras only and it may vary depending on the camera's capability
and the protocol it supports. For example, some manufacturers reserve certain presets for special
use such as wiper or menu. Please refer to camera specifications before use.

6.3.1 PTZ Control Panel

Click E on the live view window toolbar to open the PTZ control panel, which can fold and expand.

You can also move the control panel to the left by clicking .
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Parameter

Description

Control rotation direction or stop rotation.
Tip:

e You may also use shortcut PTZ control to rotate the camera: place
the mouse pointer on the live view window, and when the shape
changes to like ’, click and hold the left button to rotate the
camera.

e You can enable or disable Shortcut PTZ Control under System
Configuration > Audio & Video

e Shortcut PTZ control is not effective when 3D positioning is enabled.

Adjust focus and zoom.

e Control the light.

e Control the wiper.

e Control the IR.

e Control the heater.

e Control the snow removal function.

Adjust rotation speed.

Click the tab to enable/disable 3D positioning. With 3D positioning
enabled:

e Click somewhere on the image, and the camera automatically rotates
toward the direction.

e Drag the mouse from top to bottom to zoom in on the selected area.
Drag from bottom to top to zoom out.

Preset tab.

Patrol tab.

Auto Guard tab.
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6.3.2 Preset

Add a preset to save the status of a PTZ camera. When needed, you can rotate the camera to the
previously set position with one click of the button. Presets are also used to set a preset patrol (see
Preset Patrol).

1. Rotate the camera to the desired direction.

2. On the Preset tab, click Add Preset. Enter a preset number that is not in use; otherwise, the
existing preset will be replaced by the new preset.

6.3.3 Preset Patrol

The camera patrols along multiple presets in the set order and stays at each preset for certain length
of time. Because a preset patrol route consists of presets, you need to add all the needed presets
first (see Preset).

1. Onthe Patrol tab, click Set Patrol.

Add Patrol

Route Humber 1

+ aad Tl Delete

2. Click Add, select a preset, and set the length of time that the camera stays at this position.
Repeat this step to all the necessary presets.
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3. Use the Set Top, Up, Down, Set Bottom buttons to adjust the order in which the camera

patrols.
4. Click Save.

|I:I [Recorded Patroll

. ® +

5. The patrol route appears in the patrol route list. Click Start Patrol, and the camera will patrol

along the presets that you have set.

6.3.4 Recorded Patrol

The user operates the camera, and meanwhile the software records the movement track and status
of the camera and saves it as a patrol route. Currently one recorded patrol route is supported.

O[Recorded Fatrall
> @ +

1. Click Start Recording Patrol Route (=),

2. Use the directional buttons or shortcut PTZ control to rotate the camera to desired directions
and stay for the intended length of time. Adjust zoom and focus as needed.

3. Click Stop Recording Patrol Route. The recorded patrol route appears in the patrol route list (by
the name O[Recorded Patrol]).

4. Click Start Patrol (=). The camera will repeat the actions you performed during the patrol.

6.3.5 Auto Guard

After auto guard is enabled, the camera performs the action (start patrol or go to the preset) as
configured if no operation is made during the specified time period.
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futo Guard

duta Guard Enable | | Dizable

Mode Fatrol
Fatral a[3]

Idle State(s) &l [1-3600]

6.4 Fisheye Control

Fisheye control, set mount mode and display mode to get desired images:

e Mount: Ceiling, Wall, Desktop

e Display Mode: Original Image, 360° Panoramic+1PTZ, 180° Panoramic, Fisheye+3PTZ,
Fisheye+4PTZ, 360° Panoramic+6PTZ, Fisheye+8PTZ, Panoramic, Panoramic+3PTZ,

Panoramic+4PTZ, Panoramic+8PTZ (clicking Original Image switches from dewarping mode to
normal mode).

=7 NOTE!

e The fisheye control button is available to fisheye cameras only.

e In dewarping mode, you may click a PTZ window and then use the mouse to drag the image, or
zoom in/out using the scroll wheel; or click a panoramic window and then drag, zoom in or out on
the demarcation area.

e Digital zoom is disabled in dewarping mode, and the digital zoom button is hidden. If you switch to
dewarping mode when digital zoom is enabled, digital zoom will be disabled automatically, and the
image restores its original size.

e Dewarping mode is not available when resolution is below than D1, and the fisheye control button is
grayed out.

6.5 Tracking Mode

In tracking mode, if you play main stream of the multi-sensor camera, the camera will automatically
track the objects that trigger the set alarm rule.

1. CIickin the live view or playback window toolbar. The window is split into multiple

windows: one big window showing the panoramic image, and multiple small windows showing
PTZ images. The boxes on the panoramic image match the PTZ images.

2. Perform the following operations as needed:

e Draga box in the panoramic image to change the range of the corresponding PTZ image.
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e Scroll your mouse wheel on a box or a PTZ image to zoom in or out.

=) NOTE!
e To use auto tracking function, you need to enable perimeter protection function for the camera
first.

e Enabling tracking mode will disable digital zoom.

e Tracking mode is not available on Mac OS.

6.6 Box-Dome Linkage

View the specific details within the monitoring range quickly and clearly.
Integrated with the features of box and dome cameras, this function uses the box camera to monitor
the overall situation, and uses the dome camera to zoom in on specific details.

:& NOTE!

Before using this function, please configure panoramic linkage and perform mark calibration on the
device’s web interface.

Click on the live view window toolbar, and perform the following operations as needed:

o (Default) auto-track (): Mouse operation are not effective on the live video images of the

dome and box camera.

e Manual tracking (): The dome camera can rotate to and track the object when you click a

moving object on the live view image of the box camera.

e Drag to zoom (): Dragging on the live view image of the box camera will rotate the dome

camera to the specific area and zoom in on the area.

{ i |
e Link (): The dome camera automatically rotates to the position when you click it on the live

view image of the box camera.

You can also use the right-click menu to use the above features. Box-dome linkage and digital zoom
cannot work simultaneously.

6.7 Sequence Display

6.7.1 Sequence Resource

Play live video from cameras in a group one by one in a window. First, you need to create a sequence
resource.
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Create a sequence resource

1. On the Live View page, click the Sequence Resource tab, and then click the Add button. You
may also click Sequence Resource on the control panel to add a sequence resource.

Enter Ee

? door

? front

2. Complete settings in the window, including sequence resource name, sequence interval, video
channels to include, stream type, preset (PTZ camera). Click the Top, Up, Down and Bottom
buttons to adjust the sequence as needed.

Ti] Delets

Stream Operation

104 001 _Camers

104_00:

< [ B w
0w

<0 m

3. Click OK.
Play a sequence resource

Double-click the sequence resource on the Sequence Resource tab to start sequence display.

6.7.2 Sequence View

Sequence a default view
Play live video from cameras on the camera list in sequence based on a default view.

1. On the View tab, click the Sequence Display button for a split view. Take 4-Split view for
example.
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Enter Keywords

- . Default View

1-split|(Cy [

4-Split Sequence Display

- B Custom View

1

2. Set sequence display interval.
3. Assume there are eight cameras, and the sequence interval is set to 20 seconds. Then the

sequence is illustrated as shown below.

Cam1 | Cam?2 Cam5 | Cam6 Cam 1 Cam 2
20s 20s

Cam3 | Cam4 Cam7 | Cam 8 Cam3| Cam4

Sequence custom views
Play live video by custom views in sequence.

1. To create a custom view, click Add View.

Enter Eewwords

- B Default View
1=5plit
4—5plit

g-Split

ooz Add View

1

2. Complete the settings in the window, including the view name, window layout, binding between
the cameras/sequence resources and the windows (by dragging the cameras/sequence

24



resources to the windows or by clicking Batch Add), stream type (for cameras only) and preset

(for PTZ cameras only). Click OK when you complete the settings.

L] HH B B 8

Charmel Name

3. Repeat the above steps to create all the custom views you need.

4. Click the Sequence Display button to sequence the custom views you have created.

- W Custom View|[ )

Sequence Dizsplay

7 Recording and Playback

Record videos and search for playback or download.

7.1 Configure a Recording Schedule

Configure a recording schedule for an NVR to record video automatically. This function is available to
NVR-connected cameras only. The recorded videos are saved on the NVR, not on the PC.

Click Recording Schedule on the control panel and then follow the steps.
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7.1.1 Configure a 24/7 Recording Schedule

Use the template to configure a 24/7 recording schedule.

4.

Ft 6 10 12 14 16 18 il 22 21
N S S N N S N O

Select the camera for which you want to configure a recording schedule.
Make sure the Enable check box is selected.

Click the Select button and then select the All Day template. The green on the calendar means
time periods during which video will be recorded.

Click Save.

7.1.2 Customize a Recording Schedule

Customize based on the 24/7 recording schedule.

1.

2.

Click or drag on the green to erase, or click or drag on blank areas to draw. Clicking the Clear
button in the top right corner will clear all time periods.

In addition to the method described in step 1, you may also enter start and end times manually.
Up to 8 time periods are allowed for each day.

I I ol ] 1N N A O AN N

00 007 04:0005:30707: 00 08: 157 24:00 00: 007 00: 00 O0O: 007 00: 00 00007 00: 00 DO: 007 00 00 OO0 00 00 : 00 |Copy To: All 3 -

3. After you complete the settings for a day, you may select from the drop-down list and copy the
settings to other days. For example, select All.
4. Click Save to complete the configuration for the selected camera.
5. To make the same recording schedule for other cameras, click Copy To.
_—_& NOTE!

In addition to the All Day and Work Day templates, you may customize 8 templates to save
different recording schedules.
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7.2

7.3

7.3.1

Record Video Manually

Save live video to your PC as local recording by clicking the Start Local Recording () and Stop

Local Recording () buttons on the window toolbar. The storage path and video format are

Playback

Click Playback on the control panel to search and play recordings, including device recordings and
local recordings.

Play Device Recordings

Device recordings refer to videos stored on an NVR or an SD card that is mounted on a camera.
When you search for device recordings, the time displayed is same with the system time of the
device, not your PC. The GUI and operations may vary with the playback type you choose. We take
Normal Recording Playback for example to describe the general procedure.
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Step Description

Select the source of recording (device recording).

)
2) Select the playback type.
) Select the camera(s).
) Select or set the search time. If the device is in another time zone,

please use the local time of the device.
5) Click Search.
Note:

e In step 2, you may select a sub type to search for event recordings or
VCA recordings.

e In step 3, up to 16 cameras are supported if multiple selections are
allowed.

e In step 4: The calendar shows search results for the selected
camera(s) (blue means normal recording, and red means alarm
recording). This feature is only available to Normal Recording
Playback and Smart Recording Playback modes.

e When playback mode is set to SD in System Configuration, the
search result will show SD video does not exist if videos are not
stored in different clarity. You need to switch to HD mode and try
again. Only videos stored on NVR support switching playback mode.

7.3.2 Local Recording and Image

Search and view videos and images saved on your PC. The time of local recordings is the time of your
PC.

Step Description

Select the source of recording (local recording).

)

2) Select the camera(s).
) Select or set the search time.
)

Choose to search for recordings or pictures. The default is to search
for recordings.

5) Click Search.
201 mar Note:

ne  Wed  Thn

In step 3: The calendar shows search results for the selected cameraf(s),
and blue indicates recording on that day.
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7.3.3 Playback Control

Double-click a file on the right-side list to start playback; or click on the timeline to start playback
from the corresponding time.

Playback Toolbar

Button Description

A Set window layout.

B Close all windows.

C Click to take a snapshot of images in all windows.
Click to switch to synchronous playback mode. In synchronous playback mode,
operations (e.g., pause, resume, stop, adjust speed, click on the timeline to start
playing from that point) are effective to all the playing windows.

D
Note:
Frequent operations (such as pause/resume, adjust speed) during synchronous
playback may affect the synchronous performance.

E/H Play by frame. Click to play the previous/next frame of image.

F Pause/resume.

G Stop

I Adjust playback speed.

J Download recordings.

K Switch to full screen mode. Press Esc to exit.

L/N Move the timeline forward or backward.

M Zoom in or out on the timeline.

0] Click to open a calendar and search recordings of a different date.

Playback Window Toolbar

The window toolbar appears when the mouse pointer rests on a playing window. Operations with
the toolbar are for this window only.
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Table 7-1 Playback Window Toolbar

Button Description

A Take a snapshot and save it to your PC. The image format and storage path is
configurable in system configuration (see System Configuration).

B Digital zoom. When enabled, drag the mouse to draw an area on the image to zoom in
on, and use the scroll wheel to zoom in or out.

C Clip the video to download.

D Mute or adjust speaker sound volume on your PC.

E Current playback mode, bit rate and resolution.

@ NOTE!

e The toolbar shows i
control panel.

when the camera is a fisheye camera. Click this button to open the fisheye

[=H . . . .
e The toolbar shows when the camera is a multi-sensor camera. Click this button to enable
tracking mode.

Right-click Menu

A menu appears when you right-click a window during playback. Many functions on the menu are
same to the toolbar buttons.

For videos stored on NVR in different clarity, you can switch HD or SD videos by clicking Playback
Mode from right-click menu.

Playback by View

In normal recording playback mode, playback by view can play recordings of cameras bound to the
windows in the set window layout. On the View tab, select a custom view, select a date on the
calendar, and then click Search.

This function is only available to device recording.

7.3.4 Smart Search

The NVR records motion in different areas of the image when recording video. Smart search allows
you to locate videos that include motion in the image.
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@ NOTE!

This function is available only when the software works with certain NVR models and versions (NVR
300 series, version D021SP05 and later).

1. On the Device tab, select Smart Recording Playback from the drop-down list. Select a camera,
and then select a date on the calendar.

2. Search results appear on the timeline. The green means videos with changed images, and the
green part plays at the normal speed; other irrelevant parts play at high speed.

3. By default, smart search searches the entire screen. You may click the Draw Area button (1) and
then drag or click to edit the search area (covered by red grid).

4. Click the Finish Drawing button (2), adjust search sensitivity as needed, and then click the
Search button (3) to search again.

7.4 POS Recording Playback

Select the desired camera, enter keywords of POS information and set the start time and end time,
and then click Search.

The time when the POS information was reported appears in the right-side list. You can set the time
period before and after to view the whole video.
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To configure the position, size, color and duration of POS OSD, see System Configuration.

7.5 Recording Download

7.5.1 Download Recordings

Use the following methods to download recordings from a device to your PC. Download progress
displays in real time on the bottom toolbar.

e After a search, click the Download button () under the recording list (see Playback Toolbar)

to download recordings. Recording download is not available to smart search.
Choose a download speed:

a. High speed: Consumes more network bandwidth and PC performance and may affect other
services. This option is recommended for scenarios where there is no need to guarantee the
normal operation of other programs or services.

b. Normal speed: Consumes less network bandwidth and PC performance and has limited impact
on other services. This option is recommended for scenarios that need to guarantee adequate
performance resources and network bandwidth for other programs or services.

@ NOTE!
To search the moment when the POS information was reported from POS recording playback, you
need to set the time period before and after to view the whole video.

e Use the Start Clipping and Stop Clipping buttons on the window toolbar (see Playback Window

Toolbar).

e Use the right-click menu.
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e Click the Recording Download button (&) in the lower left corner of the GUI, search device

recordings and then download recording files. You can also download the recordings by time.

7.5.2 Manage Download Tasks

1. Click the Task Management button (E) in the lower left corner of the GUI to manage
download tasks.

2. On the Recording Download tab, view and manage download tasks. The operations for the
tasks vary with download status. You can stop download tasks, delete tasks, resume tasks, play
downloaded recordings, and open a folder to view the downloaded recordings.

Start and End Time Dovnload Pr £ Operation

04 Il # Hl, 0s o = ° Brr] - I:"E":I
Completed (0} 04 H, 05 ¢ 2 42 ing = EI Luf

@ NOTE!

e Stopping a download task does not delete the video that's already downloaded to your PC.
e You may set the file format and path at System Configuration > Audio & Video > Recording.
e Avideo player is needed to play the downloaded recordings.

8 Video Wall

Play video on a physical video wall.

Video wall is divided into DX video wall and decoding card video wall, depending on the device used
to create the video wall.

e DXvideo wall: Video wall created by using a decoding device.

e Decoding card video wall: Video wall created using a decoding card on an NVR.

@ NOTE!

e Add a decoding device or an NVR as admin first under Device Management > Device.

e The number of video walls supported, operations allowed, and functions/features available may
vary with decoding device and version.
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8.1 Add a Video Wall

_|_ Fideo Wall

Click Video Wall on the control panel. For the first time use, click and then choose

a video wall type. If a video wall already exists, click right to the video wall name to add a video
wall.
¥ideo Wall Info

Hame Video Wall 2 2 ¥ 2 2 92 ] ¥ suto-Bind Output Channel

Output Channel

1. Enter the video wall name.

2. Select the decoding device you want to use to create the video wall. The software automatically
sets the video wall size and binds decoding channels to the windows. Decoding channel names
appear on the screen.

3. Edit the video wall size, resolution or the binding between the decoding channels and windows.

5 [=]
Use the Unbind All () or Bind All ( ) button as needed.

4. Click OK.
Note:
e Make sure the video wall size is consistent with the physical video wall.

e Set small pixel pitch LED if necessary. The special LED width is the width of the last column; the
special LED height is the height of the last row. The unit is pixel.

5. To edit or delete a video wall, click ﬂ next to the video wall name.
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8.2 Video Wall Operations

8.2.1 Play Video on Video Wall

Before playing video on a video wall, you can place the mouse pointer on E after an online camera

to preview live video.

1. Dragcameras to windows to start live video on the video wall.

@ NOTE!

Some video walls require you to open window(s) on the screen first. The functions available may
vary depending on the actual video wall, for example, you may open a window manually by
dragging on the screen, automatically by choosing an existing layout, or by setting coordinates and
window size.

een Control

i +8 W01 Video Wal-w = -

1

[] B yvR304-16F—B-DT 19

Tip: To start live video from multiple cameras or group(s), select the cameras or group(s), click a
window and then click Play on Screen or Play on Wall.

e Play on Screen: Play on one window.
e Play on Wall: Play on multiple windows.

2. To play a signal source (such as from a PC), click the Signal Source tab, and then drag the signal
source to the intended window.

3. To choose a window to play alarm-triggered live video, right-click the window and click Set
Alarming Window. Make sure alarm-triggered live video is configured (see Configure
Alarm-Triggered Action for details). To cancel the setting, right-click the window and click

Cancel Alarming Window.
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NOTE!

e Only one window can be set as the alarming window.

8

e If the video wall is created using an NVR's decoding card, alarm-triggered live video is only available
to a camera under the NVR.

8.2.2 Output Audio

Use the audio output channel of a DX device to output audio of a camera playing in a window or a
screen. Only DX video wall created with certain DX device models supports this feature.

< (1), and then select the audio channel.

2. Click a window/screen, and then cIickm (2); or right-click and then select Turn Audio On. An
icon appears in the top right corner, means the audio channel is outputting audio of the IPC in
the window/screen.

3. Adjust output volume or mute the sound as needed.

8.2.3 Play Sequence Resource

Play sequence resources on video wall. Three sequence modes are available: sequence video on a
single window, sequence video on multiple windows, and sequence scenes.

Sequence on Single Window
On the Sequence Resource tab, drag a sequence resource to a window.
Sequence on Multiple Windows

On the Sequence Resource tab, select the sequence resource, click Play on Screen, and then select
the windows.
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Sequence Scenes

Scene refers to video wall settings including screen layout, window, and video service (live view or
sequence). The scene allows you to recall the video wall settings with one click of a button. Sequence
scenes is to display different scenes according to set time.

1. Click the right-side , or click on the Scene tab to create scenes.

Scene Info

2. On the Scene Sequence tab, cIick to create scene sequence plan.
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Sereen Control

Sequence By

Delete

4. Set the sequence mode. You may choose to sequence by time interval or configure a 24-hour
sequence plan.

e Sequence by interval: Display scenes one by one at set intervals, for example, 30 seconds in the
figure above.

e 24-hour plan: Enable the plan, and then set the starting time. The scene will automatically
display on the video wall at the set time. You may add scenes repeatedly as needed.
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Sequence By

Delete

] Scene Nane Start Time

O 1

5. The scene sequence plan appears on the Scene Plan tab. Click Start to start scene sequence.

Enter Hewwords

B 1 na11|

Flay

8.2.4 Virtual LED

Virtual LED is static or dynamic characters displayed on the video wall screen.

. Tirtus | . .
Click to overlay text or time on the video wall screen.

To create a virtual LED, right-click and drag the mouse on the video wall. Configure the LED by
referring to the table below. Some parameters are applicable to text LEDs, and some to time LEDs.
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The number of virtual LEDs supported by a video wall may vary with device model.

Item Description
e Text
Type .
e Time
X Coordinate (px) Set the X coordinate of the virtual LED on the screen.
Y Coordinate (px) Set the Y coordinate of the virtual LED on the screen.
Width Set the width of virtual LED.
Height Set the height of virtual LED.
Text Content Set the text that appears on the video wall screen.
Time Format Set the time format as needed.
Date Format Set the date format as needed.
e Single-line displa
Display Style 8 . . Py
e Multi-line display
Font Set font on the screen.
. e Auto
Font Size
e Custom
e Auto
Font Spacing e 1-10x: 1x means 0 characters, 2x means 0.5 characters, xx, and so
on. Character size is the same as the set font size.
Font Alignment Set the front alighment horizontally and vertically.
Font Color Set the font color on the screen.
Background Color Set the background color of virtual LED.
Set the background transparency of virtual LED.
Transparency e Yes: Do not show the background color of virtual LED.
e No: Show the background color of virtual LED.
Scrolling Speed Set the scrolling speed of the text on the video wall screen.
Scrolling Mode Set the scrolling mode of the text on the video wall screen.

8.2.5 Other Video Wall Operations

For more video wall operations, see the tables below.

00 006 00000
B A8 D> O M

The buttons on the toolbar are effective to all windows on the video wall.

No. Description

A Save scene. See Sequence Scenes for details.
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No.

Description

B Audio management, choose an audio output channel.

C Splice screens (combine several screens to make one bigger screen).

b Window management, input coordinates to create a window on the set position with
custom window height and width.

E Close all windows.

F/H Lock/unlock window position and shape.

G Start decoding in all windows.

I Stop decoding in all windows.

I Click to renumber all windows according to their positions: from top to bottom, from left

to right. The window numbers are displayed in the window's top-left corner.

Window control area. Buttons in this area are effective to a selected window. The actual buttons

available may vary depending on the video wall type and device model.

No. Description
A Split a screen.
B Start decoding.
C Stop decoding.
D Set sound volume.
E Set the specified window to display on the top of all windows.
F Set the specified window to display on the bottom of all windows.
G Display/hide the window control area.
H Display a window in full screen mode.
1/] Set stream type and preset (PTZ camera only).
K Search and play recordings.
L Close window.
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8.3 Screen Control

On the Screen Control tab, you can turn on/off screens including small pixel pitch LED screens.

Before you operate on the client, make sure the screen, the power distribution box (for LED screen),
and the server are properly connected.

8.3.1 Configure Serial Port and Protocol

Configure the serial port and protocol in accordance with the decoding device model and screen
type.

Serial Fort

Com

Frotocol

Iy
Turn On/0ff Sereen Automatically

|:| Turn On At

|:| Turn Off At

[] Twn 0ff In min(s}

8.3.2 Turn On or Off the Screen Automatically at a Set Time

1. Select Turn On At or Turn Off At, and then set the time(s) when the screen automatically turns
on or off.
2. Click Save. The screen will turn on or off automatically at the set time.

8.3.3 Turn On or Off the Screen Manually

1.
2.

Click Turn On Screen. The screen turns on immediately.

Click Turn Off Screen. The screen turns off immediately.

8.3.4 Turn Off the Screen with Delay

1. Select the check box for Turn Off In and then enter the time in the text box.
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2. Click Turn Off Screen.

3. A message as shown below appears. The screen turns off automatically when the timer expires.

& timer has been

sat.

9 Perimeter Protection

@ NOTE!

This feature requires an NVR or IPC that supports perimeter protection and needs to be configured
in advance on the device. Currently four alarm types are supported, including cross line detection,
intrusion area, enter area, and leave area.

9.1 Realtime Monitoring

View realtime monitoring screens, snapshots, and the latest alarms triggered by perimeter
protection.

Double-click a camera to start live view. Up to four cameras can be viewed at the same time.

Alarm snapshots are displayed on the right side. You can filter snapshots by alarm type and object

type. Click Details to view the detailed snapshot and alarm video.

Click in the upper right corner to stop refreshing alarms. Click again to start to refresh alarms.
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= NoTE!

e Perimeter protection is available only for devices that support perimeter protection and after
configuration has been completed on the device. See the device’s User Manual for specific
configuration.

e Alarm records are displayed in real time. Restarting the software client will clear the existing alarm
records in the realtime monitoring.

Other operations:
* Live View Window Toolbar

The window toolbar appears when you place the mouse pointer on a live view window. The toolbar
is effective only to the current window. See Live View Window Toolbar for details.

* Live View Shortcut Menu

A shortcut menu appears when you right-click a live view window. See Live View Shortcut Menu for

details.

9.2 Behavior Search

Search VCA images and recordings from an NVR.

@ NOTE!

This feature is available on certain NVR devices/versions. Currently this feature supports four alarm
types: cross line detection, intrusion detection, enter area, and leave area.

1. Follow the steps as illustrated on the image.

2. Perform the following operations as needed.

e Click a snapshot to view or download the alarm video (5) on the right side, and the alarm video
duration can be configured in System Configuration.

e Click a snapshot to view or save the alarm image (6). You can click the left or right arrow to view
the previous or next image.
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e Click (7) to switch to list mode.

e Click (8) to export search results.

10 Face Recognition

View live video, alarm records and pass-through records; manage device face libraries and
monitoring tasks. Use face recognition to search people and count people coming in and out.

10.1 Realtime Monitoring

View live video and snapshots of people passing through, view realtime alarm records.

Double-click a camera to start live video. Up to four cameras are allowed.

Perform the following operations as needed:

e Click a snapshot to view details. Click More to go to the Pass-Thru Records tab. If a face is
identified as a stranger, you can add it to a face library: put your mouse pointer on the snapshot,

B, enter the required information, and choose the target library.
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Znapshots

e View realtime alarms. Click More to go to the Alarm Records tab.
a. Choose a record type:

® Comparison Record: Click an icon to filter alarm records by comparison result ( &V for

&by

® Mask&Temperature Records: View records of people not wearing a mask and people with
an abnormal temperature.

match, for not match).

C amp arizon Rec ¥ (%,V (R';..{/

A1l Cameras

b. Click a record to view the corresponding face comparison information. Personal
information is displayed only when the degree of match between the captured face and the
face in the library reaches the set alarm threshold. See Monitoring Task for details.

e View people counting statistics. The statistics are displayed only when Mask&Temperature
Record is chosen.

To view the statistics of people not wearing a mask and people with an abnormal temperature,
you need to enable Mask Detection and Abnormal Temperature Detection first. See System
Configuration for details. The statistics are automatically cleared at 0:00 every day. You can also
click Clear Statistics to reset the statistics manually.

® 1otal 667 FoMask: 35 Abnormal Temperature: Clear Statistics

e Configure epidemic control parameters. CIickunder the live view window to configure

epidemic control parameters. See System Configuration for details.

e Configure attributes to be displayed for match faces and not match faces. CIick under the

live view window to configure attributes. See System Configuration for details.

@ NOTE!

A device reports alarms only when a corresponding monitoring task has been configured.
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10.2 Face Library Management

Manage faces in different libraries to meet different monitoring needs. The libraries are saved on the
device.

10.2.1 Create Face Library

Select the device you want to manage, then the face libraries of the device appear in the list. Click

to create a new face library. You can edit the library name or delete a library you don’t need

anymore.

Face Library

WYRI01-041LE-F4_192. 165, 2. 107

- Bl ¥VE3I01-04LE-F4 152

10.2.2 Add Face Data

Choose one of the following ways to add face data to face libraries.
Option 1: Use Batch Add

1. Click Batch Add, then select the target face library. You may select multiple libraries of different
devices.

2. Click Add, then select face images you want to add. The images must be JPG files and the size of
each photo is between 10KB and 500KB.

3. Click the edit button, enter the required information.
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Ti] Delete

Hama Date of Birth 2000/1/1

El

Gender (®) Unidentified () Male () Female  Hationality

ID Type IO Card Frovince

ID Ho. City

Hote: To continue editing click Hext.

4. Click Next to save and continue to the next, or click Finish.
5. Click OK when you complete the information for all.
Option 2: Import a file containing face data

Import a file that contains the necessary face data. The file and its content must conform to the
format, and the size of each photo is between 10KB and 500KB.

1. Click Download Template and then enter the face data into the template file.

2. Click Import and select the file you have edited. The imported data appear in the list. You can
click the button in the list's upper right corner to switch display mode.

[] select 411 — Batch add T Delste 1 Inport

3. Edit or delete face data as you need; click Export to save the face data in the current library to a
CsV file.

10.3 Monitoring Task

Create monitoring tasks using the created face libraries. The device compares the captured faces
with the faces in the libraries and reports alarms as configured.

1. Select a camera on the left, and click Add to create a monitoring task.

2. Set the task name, monitoring type, and choose a face library to be used for monitoring. Set the
alarm threshold based on your needs.
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e Match Alarm: If the similarity (or Match in Realtime Monitoring) between a captured face and a
face in the library reaches the alarm threshold, the device reports a Match alarm.

e Not Match Alarm: If the similarity between a captured face and a face in the library fails to
reach the alarm threshold, the device reports a Not Match alarm.

e All: To monitor all the faces that the device captures.

Add Monitoring Task

. Task Hame

Momi toring Type #11

#larm Thresheld

Remarks

:_@ NOTE!
Personal information such as name and ID number will not be displayed in the realtime monitoring
window for a Not Match alarm.

3. Click OK. The task is created and appears in the list. For an NVR channel, you may copy the
monitoring task to other channels of the same NVR.

10.4 Alarm Records

View alarm records generated by the configured monitoring tasks.

Choose a video channel, set search conditions including monitoring type and alarm time, and then
click Search. If you chose Match Alarm as the monitoring type, you can click More to set more
conditions including name, ID number, degree of match, mask wearing status, and body temperature

=) NOTE!

Only NVR channels supporting face detection or face recognition can be selected.

Perform the following operations as needed:

e Add the face snapshot of a stranger to a face library
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Put your mouse pointer on the face snapshot and then C|iCkL°. You need to enter the required

information including name and ID number and specify the target library.
e View details

Click a record to view alarm details.

e Exportrecords

Click Export to export all the search results.

10.5 Pass-Thru Records

View pass-through records, people counting statistics, mask wearing status, body temperatures.

Choose a video channel, set search conditions including alarm time, mask wearing status and

temperature range, and click Search.

=/ NOTE!

Only NVR channels supporting face detection or face recognition can be selected.

Perform the following operations as needed:

e Add a stranger’s face snapshot to a face library

Put your mouse pointer on the face snapshot and cIickko. You need to enter the required
information including name and ID number and specify the target library.

e View details

Click a record to view alarm details.

e Exportrecords

Click Export to export all the search results.

e Search by image

Put your mouse pointer on the face snapshot, and click E to enter the search by image page.

10.6 Search by Image

This feature supports searching people by an image from a pass-thru record.

Select a channel, upload a local image or select an image from a library, and set the time range and
match degree. Then the system will compare face images from pass-thru records and retrieve images
that exceeds the set matching threshold. The alarm video before and after the alarm image can also
be generated. The length of the alarm video (time before and after the alarm time) is configurable in
System Configuration.
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2021-10-22 00:00:00 ~ 2021-10-28 23:59:59

Match (%) O

Click a face image in the search results to view alarm images containing the face. The alarm video will
also be displayed if available.
Perform the following operations as needed:

o Click the left or right arrow below the alarm image to view the previous or next image.

o Add face to face library

Place your mouse pointer on a face image in the search results, click =8, and enter name, ID
number, etc. Click Next to add the face to the corresponding face library.

e Search by image

Place your mouse pointer on a face image, cIickm to search again based on the snapshot.

1 1 People Counting

E NoTE!
This feature requires that the camera and NVR be capable of people counting, and the camera
should be connected to a PC via the NVR.

This feature is intended for people flow counting and crowd density monitoring.

e Realtime Statistics: Display and refresh counting results of the selected area in real time.
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e Report Statistics: Display counting results in a bar chart or a line chart and export. This feature is
only available for people flow counting.

11.1 Realtime Statistics

Click People Counting on the control panel. On the Realtime Statistics tab, double-click a camera to

start the live video.

Statistics include:

e People flow counting: You can choose several channels to form a counting area. Counting results
include the numbers of people come in to, out from, and remain in the specified detection
area.You need to enable people flow counting and configure the detection area on the NVR in
advance.

e Crowd density monitoring: Count the number of people in the current area, and count each

channel separately. You need to enable crowd density monitoring and configure the detection
area on the NVR in advance.

Counting Area 1

Feople Enterad Max People Allowed

Place your mouse pointer next to the People Flow Counting folder or the People Density Monitoring
folder on the left-side tree.

Click to add a detection area, select a channel and set an alarm threshold.

Hover the mouse cursor on the counting area:

. CIickmto start people flow counting/crowd density monitoring, and then the results appear on

the right side.

* Click 48 to modify the area name, alarm threshold, and channel.

* Click to delete the area.

@ NOTE!

Live view and realtime statistics stop automatically when you close the People Counting page or
log out of the system.
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11.2 Report Statistics

On the Report Statistics tab, select a counting area and then click on _

to count directly; or set conditions first:
e Counting type: By minute, hour, day or month.
e Setatime period by selecting on the calendar or typing in the field.

e Count people entered, left and/or present by selecting the check box(es)

e Display results in a line chart or a bar chart by clicking .

@ NOTE!

e The maximum time period you can set is 60 time units, depending on the counting type
(minute, hour, day or month) you choose. For example, the maximum period is 60 months if
you choose to count by month, and 60 days if you choose to count by day.

e  This feature is only available for people flow counting.

Click Count, and results appear.
e Place the cursor on the line/column to view the number at a time point.

e Click a column title, for example, People Entered or People Left to sort the results in ascending
or descending order.

Click to display in a bar chart.

53



Click Export to export statistics as a CSV file to your PC. You can use Microsoft Office Excel to open
the file.

12 Access Control

Manage access control libraries, perform realtime monitoring, search and export entry/exit records.

12.1 Library Management

12.1.1 Add a Library

Add a library for an access control device and use the library to control access.

1.  Choose the target access control device in the drop-down list on the left.

2.  Click H behind the device name. A new library appears under the device.

3.  Click behind the new library, and enter the device name.
4 Click OK.

@ NOTE!

To automatically read IC card information when you add personal data, move the mouse to the text
box, and then swipe the IC card on the card reader.

12.1.2 Add Personal Data

Add personal data to the library. You can add data for one person at a time, for multiple person using
the Batch Add feature, or for multiple persons at a time by importing a file containing personal data
of these persons.

Option 1: Add data for one person
1. Click Add > Add One Person.
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2.  Enter the required information. Click the image on the left to upload a photo.
3.  Click Next Step, and choose the target library.

4. Click OK.

Option 2: Use batch add

1. Click Add > Batch Add, and choose the target library.

2. Click OK.

Add

[ Select 11—+ add T Delete

3.  Click Add, and select face image(s) you want to add.

4.  Click , and enter required information including name and ID.

5.  Click Next to save and continue to the next, or click Finish.
6. Click OK when you complete the information for all.

Option 3: Add data for multiple persons at a time by importing a file containing personal data of
these persons

1. Click Generate Template, and use the template to create a file containing the required personal
data.

2. Click Import, and select the target library.

3. Click m, and select the file to import (CSV or XLSX).

4. Click Import.

=) NOTE!
e Only JPG images are allowed. The size of each image must be within the range of 10KB and 500KB.

e  XLSX files cannot be imported or exported on Mac OS.

The following operations are allowed:
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. Click E in the list's upper right corner to switch display mode.

. Click Export to save data in the library to a CSV or an XLSX file.

12.2 Realtime Monitoring

View live video and snapshots of people passing through, take snapshots, use digital zoom, and open
the door remotely.

Double-click a camera or drag it to the window to start live video. Pass-through records are displayed

on the right side.

OB X B

The captured face snapshots and the corresponding library photos (if a match is found) are displayed
on the right side. You can click a record to view details, including the original snapshot, mask wearing
status and body temperature.

1D Fo

IC Card Fe.

If a face snapshot does not have a match in the library, then no library photo is displayed, and the
person will be identified as a strange. You can add the stranger to a library by placing your mouse
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pointer on the face snapshot and clicking . You need to enter a name and ID for the person and

specify the target library.

@ NOTE!

Mask detection and temperature detection are available only when they are supported by the
device and have been configured on the device. See the user manual of the access control device
for details.

If the access control device can upload original snapshots, the Show Original Snapshot button will
be displayed, and you can click it to view the original snapshot.

Up to 10 pass-through records can be displayed. The oldest record will be replaced by the new one
when more than ten pass-through records are generated.

Pass-through records are displayed in real time. Restarting the software will clear the pass-through
records in realtime monitoring.

You are recommended to configure at least one library before you view pass-through records.

The following operations are allowed:

Live view window toolbar

The window toolbar appears when the mouse pointer rests on a live view window. The toolbar is

effective only to the current window. See Live View Window Toolbar for details. The:|on the

toolbar is used to open doors.

Live view toolbar

See Live View Toolbar for details.

System configuration

CIick in the upper right corner to configure alarm sound, pop-up alarm window, etc. See System

Configuration for details.

12.3 Entry/Exit Records

Search entry and exit records by time, mask wearing status, body temperature range, authentication
result, etc. You can further filter search results by name and IC card number after setting
Authentication Result to Succeeded.

The following operations are allowed:

Add a stranger to a library quickly
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The library photo is empty when a stranger is detected. To add the stranger to a library, cIick in

the Operation column, enter the required information including name and person ID, click Next Step,
and then select the target library.

. View details

Click in the Operation column to view detailed personal information.

. Export search results

Click Export to save search results to a CSV or an XLSX file. You can choose to export only text or both
text and images.

13 E-map

First complete configuration on the Edit Map tab, and then use the map on the Map tab.

e Hot spot: Video channels, alarm input/output channels, and devices added to the map. Live
view and playback are only available for video channels.

e Hot zone: A map on a map. You may add hot spots on a hot zone.

13.1 Map Configuration

13.1.1 Add a Map

fdd Map
Click E-map on the control panel, and then click - PNG, BMP and JPEG images are

allowed. The added map appears on the page and on the Map Resources list on the left.
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On the Edit Map tab, you can:

Change the map scale: Use the scroll wheel or click the zoom buttons (1) to zoom in or out.
Eagle eye: Drag on the yellow area (2) to view details on the map (or drag map directly).

Add hot spots (3): Drag devices, video channels, alarm input/output channels to intended
positions on the map. See Add a Hot Spot for details.

Add hot zones (4): Add a map on the map. Up to 7 layers of maps are allowed. See Add a Hot
Zone for details.

Manage pictures (5): Add or delete maps. Deleting a map will also delete all hot spots and hot
zones on it.

Edit map resources (6): Edit map name, and change the icon color of hot zones.

Filter map resources (7): Choose to display video channels, alarm input/output channels or
devices on the map.

13.1.2 Add a Hot Spot

Add hot spots so you can quickly locate them on the map when any event occurs. Hot spots include

video channels, alarm input/output channels and devices. Right-click a hot spot to change color or

delete it from the map.

When adding a device hot spot, you can also add video channels and alarm input/output channels

under it. The channels and the device will appear together on a hot zone on the map. You need to

choose a map for the hot zone. Follow the steps as shown below:

IMap Hame

Add Pioture
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13.1.3 Add a Hot Zone

Follow the steps to add a hot zone.

Ficture Manazeme [z3 4dd Hot Zome _@_ Delete [] v¥ideo [ ] Alarm Input B Device [ |

Add Map

Map Hame or White

hdd Ficture

The hot zone is displayed as an icon on the map and opens when you double-click it. Right-click a hot
zone to change color or delete it from the map.

13.2 Map Operations

After you complete the configuration, click the Map tab to use the map. You may view hot spots, hot
zones, alarms, and trigger/clear alarms.

13.2.1 Locate a Hot Spot or Hot Zone on the Map

Click the Locate button to locate a hot spot or hot zone on the map.

Edit Map

Hap Eesources

&) -° [t
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13.2.2 Hot Spot Operations

Click the Select button on the top toolbar and then drag on the map to select hot spots. Different hot
spot types allow different operations:

e Video channel: Select video channels to view live or recorded videos. You may use the window
toolbar during live view.

e Alarm input: Select channels to clear alarms.

e Alarm output: Trigger/clear alarms. You can use the buttons in the Operation column or the
buttons on the top to trigger or clear alarms.

You can also right-click a hot spot to perform the above operations. For alarm input channels and

video channels, you can also view alarm information.

13.2.3 Handle Alarms

When an alarm occurs, the corresponding hot spot flashes red on the map. If the hot spot is on a hot
zone, the hot zone flashes red. Right-click the hot spot to play live or recorded video, view alarm info
or clear the alarm.

arted
Ended
arted
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13.2.4 View Hot Zone

To view a hot zone, click the hot zone map on the Map Resources list on the left, or double-click the
hot zone icon on the map.

Edit Map

M Video B Alarn Input B Device B Alarm Output

Click the main map on the Map Resources list to return.

14 Audio

Audio services include audio, two-way audio and broadcast. Two-way audio cannot work at the same
time with audio or broadcast, which means, starting two-way audio will stop audio or broadcast, and
vice versa.

Note: Broadcast is not available on Mac OS.

14.1 Audio

When live video is playing, click Bl in the window toolbar to turn on audio from the camera. The

audio is one-way from the camera to your PC and it stops when live video is closed.

Note: Turning on audio for another camera will turn off audio from the current camera.

14.2 Two-Way Audio

Two-way audio is audio communication between a device (camera or NVR) and your PC. Both the
device and the PC shall be connected to audio input and output devices.

Note: Two-way audio is available to one device at a time.
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14.2.1 Two-Way Audio with a Camera

Double-click the camera or drag it to the window on the right. When two-way audio is started, the
audio channel symbol changes (1), the two-way audio symbol flashes in the window's upper right
corner (2), and a hint appears indicating two-way audio is in use (3).

During two-way audio, you can adjust sound volume (4)(6) or stop two-way audio (5).

= NoTE!
You may also start two-way audio with a camera (camera only) by clicking
window.

O: B . .
2l in a live view

14.2.2 Two-Way Audio with an NVR

On the Two-way Audio tab, double-click the NVR or drag it to the window on the right. When
two-way audio is started, the audio channel symbol changes (1), and a hint appears (2) indicating

two-way audio is in use.
During two-way audio, you can adjust sound volume (3)(5) or stop two-way audio (4).
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14.3 Broadcast

Broadcast is one way from your PC to cameras.
1. Click the Broadcast tab. Select audio channels from the left-side list. You can:
e Select audio channels one by one.

e Select an NVR or an organization to select all audio channels under it.

2. Click Add. The selected audio channels appear on the broadcast list on the right.

n
3. After all the channels are added, click to start broadcast.

After broadcast is started, you can:
e Add more audio channels: Select audio channels on the left-side list (1) and then click Add.

Broadcast starts automatically for these channels.
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e Adjust sound volume (2) or click EEHl to turn off the microphone.
e Delete audio channels from the broadcast list: cIick (3) to delete one by one; or select the

check box (4) and then click (5) to delete in batches.

.i'l:
e  Stop broadcast: click I or close the Audio page.

@ NOTE!

Currently, broadcast to an NVR is not available.

15 Alarm Configuration

Configure action(s) to trigger when an alarm of a certain type occurs at a specified source; view
alarm records and handle alarms.

15.1 Configure Alarm-Triggered Action

Alarm configuration includes the configuration of alarm source, alarm type, device to link, and action
to trigger.

1. Click Alarm Configuration on the control panel and then follow the steps.

2. Click a tab according to the alarm type you want to configure. Take Camera Alarm for example.

e Camera alarm: includes camera online/offline, event alarm and VCA alarm.
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Device alarm: includes device online/offline, disk online/offline, high/low temperature, etc. For
DX devices, the following alarm types are available: fan failure, LED distribution box high
temperature, LED distribution box smoke alarm, fan failure cleared, LED distribution box high
temperature cleared, LED distribution box smoke alarm cleared, high/low temperature cleared.

People counting alarm: includes crowd density minor/major/critical alarm, and crowd density
minor/major/critical alarm cleared.

Select an alarm source. The subsequent settings are all configured for this alarm source.

4. Select an alarm type. An alarm of the specified type will trigger the configured actions. If you
choose face recognition match or not match alarm, make sure the monitoring task has been
configured (See Monitoring Task).

5. Configure alarm parameters.

NOTE!

Only camera alarm and device alarm can be configured.

For the following alarm types, you need to click Configuration to access the device's Web interface
and complete configuration first: motion detection, tampering detection, alarm input, audio
detection, enter area, leave area, intrusion detection, cross line detection, face detection, defocus
detection, object left behind, object removed, human body detection.

Take motion detection as an example, you need to make sure motion detection is enabled, detection

area is specified, and arming schedule is configured.

6. Click the Trigger Actions tab.

7. To receive an email alert when an alarm occurs, select the check box and complete email
configuration (see System Configuration).

8. Click Add. A dialog box appears. Select the device(s) to link and then click OK. The linked
device(s) appear on the list. The device(s) will be triggered to perform the specified action(s)
when an alarm of the specified type (step 2) occurs at the specified source (step 1).

9. Configure actions to trigger:

e Alarm-triggered live view: An alarm will trigger a pop-up window playing live video from the
camera.

e Alarm-triggered preset: An alarm will trigger the PTZ camera to rotate to the preset. The presets
in the list must be configured beforehand.

e Alarm-triggered output: An alarm will trigger the camera to output an alarm and trigger an
action by a third-party device.

e Alarm-triggered video wall: An alarm will trigger the video wall to play live video from the
camera. You need to complete video wall configuration first. Only one camera can be selected.

10. Click Save.
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@ NOTE!

e In order for alarm-triggered live view to take effect, click 22 in the bottom left corner of the GUI
and select Display Link Video.

e Triggering live video from multiple cameras may cause high CPU usage of your PC and may therefore
affect other services.

15.2 View Alarm Records

Click Alarm Records on the control panel to view alarm records, acknowledge alarms, and export
alarm data to your PC.

15.2.1 Latest Alarm
The Latest Alarm tab list alarms reported since your current login and refreshes automatically.

Hlarn Level Filter [l Seleot ALL

Tips:
You can:
e Sortrecords in ascending/descending order by clicking a header (e.g., Alarm Time).

e Acknowledge alarms: Select (or double-click) an alarm and click Acknowledge. Acknowledged
alarms are moved to the History tab.

e Click to turn on/off alarm sound.

. CIickto play an alarm video. The length of alarm video is configurable in system

configuration (Operation > Alarm > Stop Playback After and Start Playback Before).

e Click the Latest Alarm button (E2&Y) in the lower left corner of your GUI. On the page displayed,

you can turn on/off alarm sound, select/deselect Display Link Video to enable/disable
alarm-triggered live video, or double-click a record to display the full Realtime Alarm tab.
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Window

ayout [ ] Losk Current Lir

Tips:

e The window toolbar is available (see Live View Window Toolbar).

e Lock Screen: When this option is selected, the current window layout (e.g., 4-window layout) is
locked, and it does not change as new alarm-triggered live video occurs.

e Lock Current Live View: When this option is selected, the current live video will not be replaced
by new alarm-triggered live video.

e Live video stops when the set play time is over (see Configure Alarm-Triggered Action). You can

play the video again by double-clicking the alarm record in the top left area.
e Click the button in the lower left corner to open the alarm records page.

Alarm level and corresponding alarm types:

Alarm Level Alarm Type

Level 1 Manual alarm

Device offline, motion detection started, alarm input started, cross line
detection, intrusion detection, face detection, audio detection started, defocus
Level 2 detection started, scene change detection, auto tracking started, tampering
detection started, disk abnormal, disk offline, array damaged, array degraded,
face recognition match alarm, face recognition not match alarm, object left
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Alarm Level

Alarm Type

behind, object removed, human body detection, video loss started, high
temperature, low temperature, fan failure, LED distribution box high
temperature, LED distribution box smoke alarm, enter area, leave area.

Level 3 Device online, disk online.
Level 4 Reserved.
Motion detection ended, alarm input ended, auto tracking ended, audio
detection ended, tampering detection ended, array back to normal, video loss
Level 5 ended, high temperature cleared, low temperature cleared, fan failure cleared,

LED distribution box high temperature cleared, LED distribution box smoke
alarm cleared.

15.2.2 History Alarm

All alarms, including latest alarms and history alarms, can be retrieved on the History tab.

Hlarm Level Filter

You can:

Set search conditions. Click Reset to reset search conditions.

Click a header (e.g., Alarm Time) to sort records in ascending/descending order.

Choose the number of records displayed per page.

Double-click a record to view details. Alarm Time is your PC's system time when the alarm
occurs, and Device Time is the device's system time when the alarm occurs. The times can be
different. You will also find a time difference if your PC and the device belong to different time

zones.
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flarm Details

Alarm Type

Device Hame
Alarm Time

Device Time
Alarm Status

Acknowledzed Bar

e Select an alarm and click Acknowledge to acknowledge it.

e Click Export to export search results to your PC as a CSV file. Use Microsoft Excel to open it.

16 Operation Logs

Click Operation Log on the control panel to query logs and export search results to your PC. Log
information includes username, operation details and result.

You can:

e Set search conditions. Click Reset to reset search conditions.

Click a header (e.g., Log Time) to sort records in ascending/descending order.
e Choose the number of records displayed per page.
e Double-click a record to view details.

Click Export to export search results to your PC as a CSV file.
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17 System Configuration

Click System Configuration on the control panel to configure the following parameters.

Parameter Description

e Min. Delay: No delay or the shortest delay though
video quality may not be satisfactory.

Play Mode e Balanced: Balance between the video latency and
fluency.

e Fluent: Video fluency is better though video delay
may occur when network is poor.

e Adapt to Screen Layout: When this option is
selected, the client chooses a stream type
according to the number of windows:

Windows > 16: Third stream
Stream Type .
P 4 < Windows <16: Sub stream
Windows < 4: Main stream

e Use Default Stream Type: Choose the main, sub or
third stream.

Select the default playback mode: HD, SD.

Playback
Note:
Mode
This feature is only effective for videos stored on NVRs.
Transmission protocol for a camera to send video data
Audio & Video to the display window. The changed setting takes
Video Stream effect at the next startup of the software.
Transmission | Note:
Protocol e TCP is recommended in poor network conditions.
e for UDP, make sure the software is not blocked by
the firewall.

e Selected: When you maximize a live view window

Play Main by a double-click or using the shortcut menu, the

Stream in system automatically switches to the main stream if

Maximized it is not the current stream type; and when the

Live View window restores, so does the stream type.

Window e Not selected: Maximizing a live view window does
not change the stream type.

Enable

Shortcut PTZ
Control

When enabled, shortcut PTZ control is available.

Enable
Rule

VCA

When enabled, VCA rules display on the live video of
the camera that supports this function.

Note:

This feature is not available on Mac OS.
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Parameter

Description

When enabled, the software can start stream for more
cameras.

Enable GPU | The supported encoding formats (e.g., H.264, H.265)
Mode are displayed when this option is enabled.

Note:

This feature is not available on Mac OS.

e Auto: Save snapshot(s) in specified format to the
specified path.

Snapshot
Moge e Manual: In this mode, user can select the
snapshot(s) to save, set the path and format, and
enter remarks (for JPEG only).
Continuous
Snapshot Time interval between two snapshots.
Interval
Snapshot Conti
ontinuous Number of snapshots to take every time.
Snapshots
Choose the format of snapshots taken to be saved on
your client computer:
Snapshot e BMP: Save snapshots without compression. It takes
Format more space than JPEG.
e JPEG: Snapshots are compressed to save space at
the expense of reduced image quality.
D loaded .
own c?a € Format and save path of downloaded recordings.
Recording
Format and save path of local recordings.
Set the recording policy when recording space is used
up:
e Overwrite: Earliest recordings will be overwritten
Recording by new recordings when space is used up.
Local e Stop: Recording stops when space is used up.
Recording
Recording space: The disk space used to save
recordings.
Note:
It’s recommended to set at least 2GB recording space.
Recording file size: The size of a single recording.
To configure the position, size, color and duration of POS OSD in the
live view.
POS 0osSD | Duration: How long POS OSD appears on the live view.

Configuration

e Custom: Customize the duration of POS OSD.

e  Auto: Automatically resolve the duration of POS OSD set in POS
machine.
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Parameter Description
When enabled, you will automatically log in to
Enable Auto | EZStation after you start the software.
Login to | If Enable Auto Login to Windows is enabled at the
EZStation 3.0 | same time, the software will automatically start after
the computer accesses the Windows operating system.
Startup P P g3y

When enabled, automatically log in to Windows with

Enable Auto | the provided username and password at startup.
Login to Note:
Windows ’
This feature is not available on Mac OS.
Save
System Operation Retention period for operation logs.

Log For

Log
Save Alarm . .

Retention period for alarm logs.
Log For
Import . . . . .
P . . Import configurations from a configuration file.

Configuration

Maintenance
Export . . .

) . Export configurations to save as a file.

Configuration
Enable Alarm | If enabled, you can custom alarm sound duration and
Sound set different sounds for different alarm types.

Alarm
Start Length of video before/after the alarm time for
Playback playback. Use these settings to customize the length of
Before/After | alarm video that plays on the Alarm Records page.

Service Enable Auto | If enabled, the software syncs the PC's system time to
Time Sync cameras at the synchronization interval.

Operation ] ] ] ] ]
Required for alarm-triggered email (see Configure Alarm-Triggered
Action). The specified email address(es) will receive an email when an
alarm occurs.
) e Encryption Type: choose the encryption type of email transmission.

Email . .
e Sender: Email address used to send emails.
e Recipient: Email address used to receive emails.
Tip: Use the sender address as the recipient and click Send Test Email
to make a test.

Epidemic Temperature . . .

P . P Choose Celsius or Fahrenheit as the temperature unit.
control Unit
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Parameter Description

Enable/disable mask detection. When enabled, the

Mask . . .
. number of people not wearing a mask is displayed in
Detection .. . .
Face Recognition > Realtime Monitoring.
Enable/disable abnormal temperature detection.
Abnormal ,
When enabled, the number of people with an
Temperature . . .
. abnormal temperature is displayed in Face
Detection s . o
Recognition > Realtime Monitoring.
Abnormal
The system reports an alarm when the temperature
Temperature I
measured is higher than the threshold.
Threshold

When enabled, the alarm will sound when an
abnormal temperature or a person not wearing a mask
is detected. Make sure you enable Abnormal
Temperature Detection or Mask Detection first.

Alarm Sound

When enabled, an alarm window will pop up when an
Pop-up Alarm | abnormal temperature or a person not wearing a mask
Window is detected. Make sure you enable Abnormal
Temperature Detection or Mask Detection first.

When enabled, an alarm email will be sent when an
abnormal temperature or a person not wearing a mask
is detected. Make sure you enable Abnormal
Temperature Detection or Mask Detection first.

Send Email

Configure parameters to be displayed on the Realtime Monitoring,
Alarm Records, and Pass-Thru Records tabs in the Face Recognition
module. All parameters are displayed by default. You can hide certain
parameters on these tabs and still view all parameters in the Details
window.

Attribute
Display

18 User Management

Click User Management on the control panel to add, edit or delete users, and assign permissions.
"admin" is the super administrator and cannot be deleted.

1. To add a user, click Add:
e Administrator: Only admin can add administrator. Administrator has all permissions by default.

e Operator: Admin or administrator with user management permissions can add operators. An
operator has no permission by default.

2. To assign permissions, specify permissions on the left. For some permissions (e.g., Live View),
you need to select device(s) on the right.

3. To edit a user (username, password, permissions), double-click the user on the list; to delete
user(s), select and click Delete.
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@ NOTE!

Menus may be grayed out or hidden for lack of permission. Contact admin if necessary.

19 Appendix

19.1 Add an Encoding Device by EZDDNS

1. Enable UPnP on your router. Refer to router's user guide.

2. Logintothe Web interface of your device and enable port mapping (Network > Port Mapping).
e Mapping Mode: UPnP is recommended

e Mapping Type: Auto is recommended. The device and the router negotiate external ports.

e If you choose Manual, make sure the ports you set are valid; otherwise, port mapping does not
take effect.

e If external IP address is not displayed: a. make sure UPnP is enabled on the router; b. some
routers limit the number of devices for port mapping. If the maximum number has reached,
revoke unnecessary port mapping.

3. Onthe Web interface of the device, configure DDNS (Network > DDNS) as follows:
e DDNS Type: EZDDNS

e Server Address: en.ezcloud.uniview.com

e Port: 80

e Domain Name: Choose one that is easy to remember (e.g., myNVR123) and test whether it is
available.

e If configuration succeeds, the device is online, and the server address is displayed (e.g.,
en.ezcloud.uniview.com/myNVR123).

4. Add the encoding device on the software:

e Adding Mode: EZDDNS

e Device Name: Set as needed

e Domain: Domain name you get in step 3 (myNVR123 in this case)
e Enter the username and password of the device

5. Click Add.

19.2 Auxiliary Monitor Recovery

If your PC is connected to an auxiliary monitor, you can use it to display a tab (e.g., Live View) by
dragging the tab to the auxiliary monitor. The tab will remain on the auxiliary monitor when the
software restarts.
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Multi-Window Display

Drag a tab to open a new window.

Example:

B Rl
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	1. Click  (1), and then select the audio channel.
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	5. The scene sequence plan appears on the Scene Plan tab. Click Start to start scene sequence.
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	10.2  Face Library Management
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	Option 1: Use Batch Add
	1. Click Batch Add, then select the target face library. You may select multiple libraries of different devices.
	2. Click Add, then select face images you want to add. The images must be JPG files and the size of each photo is between 10KB and 500KB.
	3. Click the edit button, enter the required information.
	4. Click Next to save and continue to the next, or click Finish.
	5. Click OK when you complete the information for all.

	Option 2: Import a file containing face data
	1. Click Download Template and then enter the face data into the template file.
	2. Click Import and select the file you have edited. The imported data appear in the list. You can click the button in the list's upper right corner to switch display mode.
	3. Edit or delete face data as you need; click Export to save the face data in the current library to a CSV file.



	10.3  Monitoring Task
	1. Select a camera on the left, and click Add to create a monitoring task.
	2. Set the task name, monitoring type, and choose a face library to be used for monitoring. Set the alarm threshold based on your needs.
	3. Click OK. The task is created and appears in the list. For an NVR channel, you may copy the monitoring task to other channels of the same NVR.
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	11.2  Report Statistics

	12   Access Control
	12.1  Library Management
	12.1.1  Add a Library
	1. Choose the target access control device in the drop-down list on the left.
	2. Click  behind the device name. A new library appears under the device.
	3. Click  behind the new library, and enter the device name.
	4. Click OK.

	12.1.2  Add Personal Data
	1. Click Add > Add One Person.
	2. Enter the required information. Click the image on the left to upload a photo.
	3. Click Next Step, and choose the target library.
	4. Click OK.
	1. Click Add > Batch Add, and choose the target library.
	2. Click OK.
	3. Click Add, and select face image(s) you want to add.
	4. Click , and enter required information including name and ID.
	5. Click Next to save and continue to the next, or click Finish.
	6. Click OK when you complete the information for all.
	1. Click Generate Template, and use the template to create a file containing the required personal data.
	2. Click Import, and select the target library.
	3. Click , and select the file to import (CSV or XLSX).
	4. Click Import.
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	13   E-map
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	14   Audio
	14.1  Audio
	14.2  Two-Way Audio
	14.2.1  Two-Way Audio with a Camera
	14.2.2  Two-Way Audio with an NVR

	14.3  Broadcast
	1. Click the Broadcast tab. Select audio channels from the left-side list. You can:
	2. Click Add. The selected audio channels appear on the broadcast list on the right.
	3. After all the channels are added, click  to start broadcast.


	15   Alarm Configuration
	15.1  Configure Alarm-Triggered Action
	1. Click Alarm Configuration on the control panel and then follow the steps.
	2. Click a tab according to the alarm type you want to configure. Take Camera Alarm for example.
	3. Select an alarm source. The subsequent settings are all configured for this alarm source.
	4. Select an alarm type. An alarm of the specified type will trigger the configured actions. If you choose face recognition match or not match alarm, make sure the monitoring task has been configured (See Monitoring Task).
	5. Configure alarm parameters.
	6. Click the Trigger Actions tab.
	7. To receive an email alert when an alarm occurs, select the check box and complete email configuration (see System Configuration).
	8. Click Add. A dialog box appears. Select the device(s) to link and then click OK. The linked device(s) appear on the list. The device(s) will be triggered to perform the specified action(s) when an alarm of the specified type (step 2) occurs at the ...
	9. Configure actions to trigger:
	10. Click Save.

	15.2  View Alarm Records
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	16   Operation Logs
	17   System Configuration
	18   User Management
	1. To add a user, click Add:
	2. To assign permissions, specify permissions on the left. For some permissions (e.g., Live View), you need to select device(s) on the right.
	3. To edit a user (username, password, permissions), double-click the user on the list; to delete user(s), select and click Delete.

	19   Appendix
	19.1  Add an Encoding Device by EZDDNS
	1. Enable UPnP on your router. Refer to router's user guide.
	2. Log in to the Web interface of your device and enable port mapping (Network > Port Mapping).
	3. On the Web interface of the device, configure DDNS (Network > DDNS) as follows:
	4. Add the encoding device on the software:
	5. Click Add.

	19.2  Auxiliary Monitor Recovery
	Multi-Window Display


